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Financial Year-End 2021/2022   

 

A. Overview of Financial Year end 2021/22 

 

There are changes to the chart of accounts for the year ended 31st August 2022 and 

they are set out in the tables included in Appendix 1 in Financial Guideline 

2021/2022 – 40.  

 

The latest chart of accounts is available here, (June 2022). It is important to compare 

the current list of nominal codes in your school’s accounts package with this revised 

chart of accounts to ensure that both are in alignment.  

 

Some of these new codes give rise to changes in where we code fixed asset additions 

going forward and we will provide training to cover these changes in our on-demand 

Sage 50 webinar training videos available on our website.  

 

 

B. COVID Grants:  

 

The accounting for COVID Grants and the related expenditure continued to dominate 

the accounts function for the financial year and the Department of Education (DE) have 

requested that any unspent COVID-19 Capitation related grants for the 2021/22 

school year should be repaid. They have requested it as one lodgement covering all 

grants (Enhanced Cleaning, PPE, and Enhanced Supervision as appropriate) and it 

should be returned by schools to the DE’s bank account by electronic funds transfer by 

30th September 2022.  

 

To arrive at the correct repayment figure, it is vital that schools have recorded 

correctly all COVID costs paid from all the COVID grants received under the correct 

COVID code and that the accuracy of these postings is checked thoroughly. Where 

the Department report is used and relied upon to verify the repayment figure, it is 

crucial to check that every COVID transaction is correctly allocated to that relevant 

COVID department number in Sage 50. Please be aware that the COVID Minor 

Works grant should be excluded from this repayment calculation. Further guidance on 

the calculation of this COVID repayment is available here on our website.  
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https://www.fssu.ie/app/uploads/2022/06/40-22-Financial-Guideline-Revised-FSSU-Chart-of-Accounts-June-2022.pdf
https://www.fssu.ie/app/uploads/2022/06/40-22-Financial-Guideline-Revised-FSSU-Chart-of-Accounts-June-2022.pdf
https://www.fssu.ie/app/uploads/2022/06/FSSU-Chart-of-Accounts-June-2022.pdf
https://www.fssu.ie/post-primary/topics/sage-50-accounts/training/webinar-training/
https://www.fssu.ie/post-primary/topics/return-of-unspent-covid-capitation-funding-supports/
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C. Summary of key deadlines:  
  

The school should aim to supply all financial information to their external 

accountant/auditor for the school year ending 31st August 2022 by September 30th, 

2022.  

Sage 50 Security Upgrade – Deadline September 2022  

 

Sage is making essential security updates to the software and any schools using 

versions lower than 27.2 will not be able to access their software after September 

2022. Therefore, it is vital to check the version of Sage and upgrade immediately to 

Version 28.1 to ensure continued access to the software.  

 

Upgrade to Sage 50cloud Accounts 

 

The FSSU want to ensure that all schools have a robust and efficient accounts package 

and following our recommendation to upgrade to Sage 50cloud Accounts, a 

considerable number of Voluntary Secondary Schools have upgraded and are 

availing of the remote data access and bank feeds features available with the 

software. In particular, the setting up of remote data access for your Accountant will 

enhance the efficiency of the school accounts preparation process this year. 

 

If you haven’t already upgraded please complete the purchasing form and email it 

to the addresses noted on the form. 

Year-end procedure in Sage 50 should be processed by early November 2022 
 
To run the BOM reports for the new year which includes the budget for 2022/2023 and 
prior year figures, the Financial Year End must be processed in Sage 50. We would 
suggest that the latest date for running the Year end in Sage should be the first week 
in November 2022 to ensure that the Board of Management receive all the definitive 
reports for the new financial year. 

 

D. Preparation for Year End 2021/22 

• It is important that school’s chart of accounts is in alignment to the revised FSSU 

Chart of accounts so therefore it is advised to compare the current list of nominal 

codes in your schools Sage 50 with the revised FSSU chart of accounts to check 

for any inconsistencies. A revised FSSU Chart of accounts is available here. 

 

This will facilitate the inputting of the accounts into the FSSU Online accounts 

submission system by your external accountant/auditor and reporting of financial 

information to the Department and to the Charities Regulator. 

 

 

 

https://www.fssu.ie/app/uploads/2021/01/Sage-50Cloud-Purchasing-Form-19.04.22_rev.pdf
https://www.fssu.ie/app/uploads/2022/06/FSSU-Chart-of-Accounts-June-2022.pdf
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Before running the year end 2021/22: Done 

1. Post all day-to-day transactions for the year. This ensures that 

your management reports and year end postings are accurate. 

Ideally any audit adjustments from the accountants should be 

posted to the income and expenditure codes within a reasonable 

time frame. 

 

2. Ensure you have bank statements for all school bank accounts 

covering the period 1st September 2021 to 31st August 2022 

and ensure all bank accounts are reconciled up to 31st August 

2022.  

 

3. Review the bank reconciliation report as follows: 

a. Review the list of outstanding payments and receipts on 

the bank reconciliation to ensure they are accurate.  

b. Any duplicate entries should be corrected.  

c. Any outstanding payments/receipt more than six-months-

old should be investigated. 

 

4. Ensure that the petty cash and credit card transactions are 

recorded for the year and that the balances in the petty cash 

and credit card account are correctly stated at the end of the 

year. 

 

5. Ensure that the balance in the cash control account equates to the 

amount of cash and cheques held in the safe on 31st August 

2022. 

 

6. Ensure that the balance in the online payment solution clearing 

account (code 1870) equates to the amount of money owed from 

the online payments company at the 31st of August 2022. 

 

7. Payroll records: Print individual employee payroll records for the 

period 1st September 2021 to 31st August 2022, print copy of 

the payroll summary for the 2021 year and have a backup of 

the payroll saved to a memory stick for 2021 and up to 31st 

August 2022  

 

8. The PAYE/PRSI/USC/LPT control account (nominal code 2250) 

should equate to the PAYE/PRSI/USC/LPT that is owed to 

Revenue at 31st of August 2022 (where payroll journals are 

utilised). 

 

9. The net wages control account (code 2200) should be zero or 

any balance explained. 

 

10. Other wage related control account balances (e.g. Union Fees, 

Single Public Pension Scheme, ASC) should equate to amounts 
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owed at 31st August 2022 (if recording payroll using the payroll 

journal). 

11. VAT: Review ROS to ensure all VAT returns are filed. Remember 

you must file VAT returns even if liability is Nil. 

The VAT control account (nominal code 2260) should equate to 

the VAT that is owed to Revenue at 31st of August 2022 (if using 

VAT journals). 

 

12. RCT: Ensure all deductions made from Subcontractors for RCT 

purposes have been returned to Revenue  

 

13. Parents Association: Ensure all financial documentation is made 

available to the school’s external accountant/auditor for inclusion 

in the annual financial accounts of the school.  

 

14. Complete a manual list of creditors on 31st August 2022 (money 

owed by the school). If using the purchase ledger print an 

outstanding creditors list at 31st August 2022.  

 

15. Complete a manual list of debtors & prepayments at 31st August 

2022 (money owed to the school). If using the sales ledger print 

an outstanding debtors list at 31st August 2022. 

 

16. Income received in the current year (2021/22), for the next 

school year (2022/2023) should be shown as income received in 

advance on the balance sheet code 2105. Use the department 

function to analyse the various types within the nominal account. 

This will facilitate the running of a nominal activity report by 

department for code 2105 at 31.08.2022 for audit purposes.  

 

17. Alternatively, complete a manual list of income/grants received 

by the school in the year 2021/22 that relate to 2022/2023 

school year e.g. book grant, transition year charges, school 

administration charges, voluntary contribution.  

 

18. Review the grants for the year to ensure that all grants received 

for the next academic year have been included in the accounts 

as Grants Received in Advance (nominal codes 2150-2152).  

 

19. Review the income and expenditure for ring fenced 

grants/income and carry any unspent amounts forward as 

unspent grants/income. See Appendix 2 for further information. 

 

20. Ensure the balances of COVID grants unspent is correctly 

accounted for. See Appendix 1 for further information. 

 

21. Run a Nominal Activity Report and review the posting of 

transactions, to ensure they are accounted for correctly. 

 

22. Year-end Adjustments for creditors, debtors and income received 

in advance should be posted to SAGE 50 at 31.08.2022 before 

running year end if possible. 
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E. Print out the recommended Financial Reports for the year end. 

Reports To Run Reports 

Trial Balance Nominal codes > Trial Balance 
Nominal codes > Reports > Trial Balance 

Balance Sheet Nominal codes > Reports > My nominal code reports >BOM 
Balance Sheet 
 

Profit & Loss Nominal codes > Reports> My nominal code reports>BOM 
Income & Expenditure Account 
 

Nominal Activity  Nominal codes > Reports> Nominal Activity 
 

Unreconciled 
Payments/Receipts 

Bank accounts > Reports > Unreconciled transactions 
 

Aged creditors 
report 
(only for schools 
using the Supplier 
module) 

Suppliers > Reports > Aged creditors > Aged creditors summary  
Suppliers > Reports > Aged creditors > Aged creditors detailed 
Suppliers > Reports > Activity > supplier activity detailed 

Aged debtors 
report 
(only for schools 
using the Customer 
module) 
 

Customers > Reports > Aged debtors > Aged debtors analysis 
summary  
Customers > Reports > Aged debtors > Aged debtors analysis 
detailed 
Customers > Reports > Activity>customer activity detailed 
 

Department report 
for code 2105 

Department > Reports > Nominal Analysis > Nominal 
Department analysis detailed > nominal code 2105 and default 
on the dept numbers 
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Department report 
for COVID 
transactions 
 
 
 
 
 
 
 
 
 
 
 
 
 

Departments > Reports > Nominal Analysis > Nominal 
Department analysis detailed > department no 1 is COVID in 
this example. Let nominal code default so it will give every code 
where dept 1 is assigned. 
 
 

 
 
NB: If COVID transactions were not assigned the relevant dept 
number then they will not appear in this report.  

 

F. System Back-Up 
 

Take A Minimum of TWO Backups and save to two separate locations (external 
hard-drive/Network). Name it ‘Before Year End’- it is essential to back up the data 
before running the year end, as this is the only way to go back to a pre-year 
position.  
Please see Section G for running your year end in Sage 50. Further information or 
clarification on any of the issues raised in this Guideline can be obtained from the 
FSSU.  
 

G. Processing the Year End in Sage 50 

 
Schools should liaise with their external accountants/auditors and request them to 

review the school accounts as soon as possible and to return a draft Trial Balance 

which will include any changes to the income and expenditure for the year. The 

necessary audit adjustments can be inputted into Sage 50 before processing year 

end and the Income and Expenditure figures appearing in the archived accounts will 

substantially agree to the signed Financial Statements at 31.8.2022. If there are 

further changes after processing the year end, the adjustments can be made to the 

Balance Sheet codes dated 31.08.2022. 

Sage 50 has a soft year end, and this means you can post into your new financial year 
before running the Year End option. It's important to make sure the transaction date 
is correct. A message advises that the date is outside the current financial year, click 
Ok or Yes. The following reports can be run for the new financial year until you run 
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the year end - Transactional Profit and Loss, Transactional Balance sheets and 
Transactional Trial Balances reports. Please note these reports are for internal/office 
use and should not be used for board of management meetings.  

To run the BOM reports for the new year which includes the budget for 2022/2023 and 
prior year figures, the Financial Year End must be run in Sage 50. Therefore, this year-
end process cannot be put off for audit adjustments for too long into the new Financial 
Year. We recommend that the latest date for running the Year end in Sage should be 
the first week in November 2022 to ensure that the board of management receive all 
the definitive reports for the new financial year. 

Where Sage is setup on a network, the year-end routine should be run on the computer 
that holds the data. If you have a large dataset, it may take a little time to run the 
process. This time will be reduced if you run the routine on the computer that holds your 
accounts data. 

 

1. Running the Financial Year End 

• Change the program date - change the program date to be the last day of the 
financial year. e.g., 31st August 2022. 

• Take TWO backups labelled ‘Before Year End’- it is essential to back up the data 

before running the year end, as this is the only way to go back to a pre-year 
position. It is advisable to take two backups as a precaution against loss or 
damage of the backup media. 

• To run the Year End, select Tools >Period End >Year End.  

• This will display the year end window and complete all the steps. 

• Archive Data – select the option to archive data. This will enable you to view old 
data without having to restore old backups.  

• Check the details shown at the bottom of the Year End window are correct 
before selecting the Run Year End option.  

• Click YES if the Year End dates are correct.  

• A year end progress screen will appear. Once complete you will be asked if 
you would like to print the Year End journal. Click ok. 

• A final message appears that the financial year end has been completed, click 
OK. 

2. Check Data After Running the Year End  

Run a Brought Forward trial balance. Select Modules >Nominal codes >Trial 
Balance for the period select Brought Forward 
 

• Make sure there are no income and expenditure codes on this report 

• Next, Check your data again. File>Maintenance > check Data 

• Finally take another backup of the data and label it ‘After Year End’ 
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• Do NOT clear the audit trail. However, if there are more than two years 
accounts data on Sage 50 and if Sage processing appears to be slowing down 
then clearing the audit trail should be considered. Please refer to our Sage 50 
section of the website for details on this process. 
 

Full details on running the year end are in ‘FSSU SAGE Accounts Manual-Section 

8’.  

3. The school Budget for 2022/2023 should now be imported into Sage 50.   

There is a new excel sheet included in the Budget Template 2022/2023 called “Sage 
50 Import” which provides a summary of the nominal codes and the total budget 
figures for the year. The details in Column A, B & D of this sheet can be copied into a 
template available in Sage 50, and this will enable the budget data to be imported 
into Sage 50. Previously these figures would have been filled in manually into a Sage 
Budget Import Template. 

See here on our website for guidance along with a demo video on the process. 

Please ensure that your budget import template has the same nominal codes that 
exist in your Sage 50 accounts and that a backup is taken before importing the 
information.  

4. Audit adjustments 

Once the year end is run, any audit adjustments for the 2021/22 Accounts should be 
dated 31.08.2022 and should only be made to Balance Sheet codes with Income and 
Expenditure adjustments recorded in the Revenue Reserves code 2710. 

5. Prior year comparatives 

For those schools who want their Income and Expenditure Account showing the prior 
year, year to date comparatives instead of the full prior year, this optional report 
along with the instructions on how to copy into Sage 50 are available on the Getting 
started in Sage 50 section of our website. 

 

H. Sage 50 Training 

This year the FSSU are creating a series of Sage 50 on demand videos which will be 
available on our website. The on-demand videos will be short and will provide 
guidance on specific topics such as amending the chart of accounts, importing the 
budget and recording fixed asset additions in Sage 50 using the latest nominal codes. 
We will also run webinar training sessions for preparing for and finalising the year 
end.  

https://www.fssu.ie/post-primary/topics/sage-50-accounts/manual-guides/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/training/training-videos/importing-the-budget/
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The FSSU will continue to provide ongoing support and training to facilitate and assist 
schools with the new features available in Sage 50cloud Accounts particularly with the 
use of bank feeds as this will enhance the efficiency and timeliness of the accounts 
function. 

 

Tel: 01-269 0677  

info@fssu.ie  

 

7th September 2022 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

mailto:info@fssu.ie
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Appendix 1: Accounting for Unspent COVID Grants  

 
The portion of unspent COVID grant balances must be accounted for at the end of the 
year using the relevant balance sheet code/s (2181-2185) in the chart of accounts.  
 
To account for the unspent grants, follow the steps below: 
 

▪ Step 1: Calculate the amount of the grant unspent at the 31.08.2021 (Income Less 
Expenditure) 

▪ Step 2: Post a journal dated 31.08.2022 to transfer the unspent element to the 
balance sheet.  

▪ Note: As the unspent portion of the COVID grants at the 31.08.2022 is to be 
returned to the Department by the 30.09.2022 there is no need to journal the 
grants back into the Income & Expenditure code on the 01.09.2022 
 

Click here for a worksheet to assist with the accounting of unspent COVID grants. 
 
 
 

 

 

 

 

 

 

 

 

 
 
 
 
 

Grant 

Step 1 Step 1 Step 1 Step 2 

Income 
 

Expenditure 
 

Balance of 
Grant at 

31.08.2022 
 

Journal Unspent amount at 
31.08.2022 

Nominal 
Code 

Amount Nominal Code Amount Amount Dr Code 
 

Cr Code Dep. 

COVID 
Capitation 
PPE Grant 

3281 €19,000 5802 €18,600 €400 3281 2182 COVID 

https://www.fssu.ie/post-primary/topics/return-of-unspent-covid-capitation-funding-supports/
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Appendix 2: Accounting for Unspent Grants/Income 

 
Some grants/incomes are received for a specific purpose, for example the ICT grant 
and the supervision & substitution grant. These are known as ringfenced grants. The 
unspent portion of these grants should be deferred until it is spent by the school. 
 
The portion of unspent ringfenced grant balances must be accounted for at the end of 
the year using the relevant balance sheet code/s (2160-2180) in the chart of accounts.  
 
The following grants are examples of ringfenced grants. 

➢ Book Grant, Supervision and Substitution Grant, ICT Grant, Bus Escort Grant, 
Schools Meal Grant, All Capital Grants, etc. 
 

To account for the unspent grants, follow the steps below: 
 

▪ Step 1: Calculate the amount of the grant unspent at the 31.08.2022 (Income Less 
Expenditure) 
 

▪ Step 2: Post a journal dated 31.08.2022 to transfer the unspent element to the 
balance sheet.  
 

▪ Step 3: Post a journal dated 01.09.2022 to transfer the unspent element back to 
the Income & Expenditure report for use in the 31.08.2022 year. 

 

 

Table 1: Example of Accounting for unspent grant 

 
 
 
 
 

Grant 

Step 1 Step 1 Step 1 Step 2 Step 3 

Income 
 

Expenditure 
 

Balance of 
Grant at 

31.08.2022 
 

Journal Unspent 
amount at 
31.08.2022 

 

Journal Unspent 
amount at 
01.09.2022 

 

Nominal 
Code 

Amount Nominal 
Code 

Amount Amount Dr 
Code 
 

Cr 
Code 

Dr 
Code 

Cr Code 

Book Grant 3150 €9,600 4730 €8,900 €700 3150 2160 2160 3150 

Supervision 
& 
Substitution 
Grant 

3240 €5,130 4150 €4,200 €930 3240 2170 2170 3240 
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School 
Library 
Books 
Capital 
Grant 

3155 €15,000 4641 €1,000 €14,000 3155 2161 2161 3155 

Bus Escort 
Grant 

3294 €4,000 4196 €3,500 €500 3294 2171 2171 3294 

DSP School 
Meals 

3296 €30,000 4912 €26,000 €4,000 3296 2171 2171 3296 

Digital 
Strategy/IC
T Grant 
(Non 
Capital) 

3230  €27,500 4410  €17,500 €10,000 3230  2165 2165 3230 

Digital 
Strategy/IC
T Grant 
(Non 
Capital) 

3921 €27,500 1461(14
60) 

€17,500 €10,000 3921 2165 2165 3921 

Digital 
Divide  
Grant (Non 
Capital) 

3230  €20,000 4410  €17,500 €2,500 3230  2179 2179 3230 

Digital 
Divide  
Grant 
(Capital) 

3921 €20,000 1461(14
60) 

€17,500 €2,500 3921 2179 2179 3921 

Capital 
Grant: 
Building 
 

3900 €90,000 3940 €80,000 €10,000 3900 2171 2171 3900 

Capital 
Grant: 
Equipment 

3920 €25,000 1421 €20,000 €5,000 3920 2171 2171 3920 
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Teach Emmet, Baile an Mhuilinn, Baile Átha Cliath 14 
Guthán: 01 2690677 R-phost: info@fssu.ie 

   

 
 

 

                                    
 

Deireadh na Bliana Airgeadais 2021/2022   

 
A. Forléargas ar Dheireadh na Bliana Airgeadais, 2021/22 

 

Tá athruithe ar chairt na gcuntas don bhliain dar críoch an 31 Lúnasa 2022 agus tá 

siad leagtha amach sna táblaí atá san áireamh in Aguisín 1 i dTreoirlíne Airgeadais 

2021/2022 – 40.  
 

Tá cairt na gcuntas is déanaí ar fáil anseo, (Meitheamh 2022). Tá sé tábhachtach liosta 

reatha na gcód ainmniúil i bpacáiste cuntas do scoile a chur i gcomparáid le cairt na 

gcuntas athbhreithnithe lena chinntiú go bhfuil siad ailínithe le chéile.  
 

Eascraíonn athruithe as cuid de na cóid nua seo san áit a ndéanaimid breisithe 

sócmhainní seasta a chódú ag dul chun tosaigh agus cuirfimid oiliúint ar fáil chun na 

hathruithe seo a chlúdach inár bhfíseáin oiliúna seimineár gréasáin Sage 50 ar 

éileamh atá ar fáil ar an suíomh gréasáin.  
 

 

B. Deontais COVID:  
 

Bhí cuntas a thabhairt ar Dheontais COVID agus ar an gcaiteachas gaolmhar fós chun 

tosaigh i bhfeidhm na gcuntas don bhliain airgeadais agus d’iarr an Roinn Oideachais 

(RO) go n-aisíocfaí aón deontais neamhchaite a bhain le Caipitíocht COVID-19 don 

scoilbhliain 2021/22. D'iarr siad go ndéanfaí é a sholáthar mar thaisceadh amháin a 

chlúdódh na deontais go léir (Glantachán Feabhsaithe, TCP, agus Maoirseacht 

Fheabhsaithe de réir mar is cuí) agus ba cheart do scoileanna é a sheoladh ar ais chuig 

cuntas bainc na RO trí aistriú leictreonach cistí faoin 30 Meán Fómhair 2022.  
 

Chun teacht ar an bhfigiúr aisíocaíochta ceart, tá sé ríthábhachtach go mbeadh gach 

costas COVID a íocadh ó na deontais uile a fuarthas faoin gcód COVID ceart 

taifeadta i gceart ag na scoileanna agus go ndéanfaí cruinneas na bpostálacha sin a 

sheiceáil go críochnúil. Sa chás go n-úsáidtear agus go mbítear ag brath ar thuarascáil 

na Roinne chun an figiúr aisíocaíochta a fhíorú, tá sé ríthábhachtach seiceáil a 

Treoirlíne Airgeadais 2022/2023 - 07 

     
 

 

 

    Meánscoileanna Deonacha 

 

 

 

  

  

https://www.fssu.ie/app/uploads/2022/06/40-22-Financial-Guideline-Revised-FSSU-Chart-of-Accounts-June-2022.pdf
https://www.fssu.ie/app/uploads/2022/06/40-22-Financial-Guideline-Revised-FSSU-Chart-of-Accounts-June-2022.pdf
https://www.fssu.ie/app/uploads/2022/06/FSSU-Chart-of-Accounts-June-2022.pdf
https://www.fssu.ie/post-primary/topics/sage-50-accounts/training/webinar-training/
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dhéanamh go ndearnadh gach idirbheart COVID a leithdháileadh i gceart ar uimhir 

ábhartha COVID na Roinne i Sage 50. Tabhair faoi deara gur cheart deontas Mion-

Oibreacha COVID a eisiamh ón ríomh aisíocaíochta seo. Tá tuilleadh treorach faoi 

ríomh na haisíocaíochta COVID seo ar fáil anseo ar ár suíomh gréasáin. 
 

C. Achoimre ar na príomh-spriocdhátaí:  

  

Ba cheart don scoil gach iarracht a dhéanamh an fhaisnéis airgeadais uile maidir leis 

an scoilbhliain dar críoch an 31 Lúnasa 2022 a sholáthar dá cuntasóir/hiniúchóir 

seachtrach faoin 30 Meán Fómhair 2022.  

Uasghrádú Slándála Sage 50 – Spriocdháta Meán Fómhair 2022  

Tá Sage ag déanamh nuashonruithe slándála riachtanacha ar na bogearraí agus ní 

bheidh aon scoileanna a úsáideann leaganacha níos ísle ná 27.2 in ann rochtain a fháil 

ar a mbogearraí tar éis Mheán Fómhair 2022. Dá bhrí sin, tá sé ríthábhachtach an 

leagan Sage a sheiceáil agus uasghrádú a dhéanamh láithreach chuig Leagan 28.1 

chun rochtain leanúnach ar na bogearraí a chinntiú.  
 

Uasghrádú chuig Cuntais Sage 50cloud 

Is mian le FSSU a chinntiú go bhfuil pacáiste cuntais láidir agus éifeachtúil ag gach 

scoil agus tar éis ár moladh uasghrádú a dhéanamh ar Chuntais Sage 50cloud, tá 

uasghrádú déanta ar líon mór Meánscoileanna Deonacha agus go bhfuil siad ag baint 

leasa as na gnéithe cianrochtana sonraí agus fothaí Bainc atá ar fáil leis na bogearraí. 

Go háirithe, cuirfidh bunú cianrochtain sonraí do do Chuntasóir le héifeachtúlacht 

phróiseas ullmhúcháin na gcuntas scoile i mbliana. 
 

Mura bhfuil uasghrádú déanta agat cheana féin comhlánaigh an fhoirm cheannaigh 

agus seol ríomhphost chuig na seoltaí a tugadh faoi deara ar an bhfoirm. 

Ba chóir nós imeachta deireadh bliana i Sage 50 a phróiseáil faoi thús mhí na 

Samhna 2022 

Chun tuarascálacha an Bhoird Bhainistíochta a rith i gcomhair na bliana nua, lena 

n-áirítear an buiséad le haghaidh 2022/2023 agus figiúir na bliana roimhe sin, ní 

mór Deireadh na Bliana Airgeadais a phróiseáil in Sage 50. Mholfaimis gurb é an 

dáta is déanaí chun Deireadh na Bliana a reáchtáil i Sage an chéad tseachtain i mí na 

Samhna 2022 chun a chinntiú go bhfaighidh an Bord Bainistíochta na tuairiscí 

cinntitheacha go léir don bhliain airgeadais nua. 

 

 

 

https://www.fssu.ie/post-primary/topics/return-of-unspent-covid-capitation-funding-supports/
https://www.fssu.ie/app/uploads/2021/01/Sage-50Cloud-Purchasing-Form-19.04.22_rev.pdf
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D. Ullmhú do Dheireadh na Bliana 2021/22 

 

• Is tábhachtach go mbeadh Cairt Cuntas na scoile i gcomhréir le Cairt Cuntas 

athbhreithnithe FSSU; mar sin, moltar an liosta reatha cód ainmniúil in Sage 50 

do scoile a chur i gcomparáid le Cairt Cuntas athbhreithnithe FSSU chun a 

sheiceáil an ann d’aon neamhréireachtaí. Tá cóip de Chairt Cuntas 

athbhreithnithe FSSU ar fáil anseo. 
 

Éascóidh sin obair do chuntasóra/d’iniúchóra seachtraigh maidir le iontráil na 

gcuntas i gcóras seolta cuntas ar líne FSSU, agus tuairisciú faisnéis airgeadais 

don Roinn agus don Rialálaí Carthanas. 
 

 

Sula ndéantar tuarascálacha deireadh bliana 2021/22 a rith: Déanta 

1. Déan na hidirbhearta uile ó lá go lá i gcomhair na bliana a 

bhreacadh síos. Ar an mbealach sin, is féidir a áirithiú go 

bhfuil do chuid tuarascálacha bainistíochta agus breacadh 

dheireadh na bliana cruinn. B’fhearr aon choigeartuithe ó na 

cuntasóirí a bhreacadh leis na cóid Ioncaim agus chaiteachais 

laistigh de thréimhse ama réasúnta. 

 

2. Áirithigh go bhfuil ráitis bhainc agat maidir le cuntais uile na 

scoile, lena gcumhdaítear an tréimhse ón 1 Meán Fómhair 

2021 go dtí an 31 Lúnasa 2022 agus áirithigh freisin go bhfuil 

na cuntais bhainc go léir réitithe suas go dtí an 31 Lúnasa 

2022.  

 

3. Déan athbhreithniú ar an tuarascáil imréitigh bhainc mar seo a 

leanas: 

a. Déan athbhreithniú ar liosta na n-íocaíochtaí amuigh 

agus na bhfáltas ar an ráiteas imréitigh bainc lena 

chinntiú go bhfuil siad cruinn ceart.  

b. Ba cheart gach iontráil dhúblach a cheartú.  

c. Ba cheart gach íocaíocht/fáltas atá níos sine ná sé mhí 

d’aois a iniúchadh. 

 

4. Áirithigh go ndéantar na hidirbhearta mionairgid agus cárta 

creidmheasa a bhreacadh síos i gcomhair na bliana agus go 

luaitear na hiarmhéideanna sa chuntas mionairgid agus carta 

creidmheasa i gceart ag deireadh na bliana. 

 

5. Áirithigh go bhfuil an t-iarmhéid sa Chuntas Rialaithe Airgid i 

gcomhréir le méid an airgid thirim agus na seiceanna atá á 

gcoimeád sa taisceadán ar an 31 Lúnasa 2022. 

 

https://www.fssu.ie/app/uploads/2022/06/FSSU-Chart-of-Accounts-June-2022.pdf
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6. Áirithigh go bhfuil an t-iarmhéid sa chuntas imréitigh 

íocaíochtaí ar líne (cód 1870) i gcomhréir leis an méid airgid 

atá dlite ón gcuideachta íocaíochtaí ar líne amhail ar an 31 

Lúnasa 2022. 

 

7. Taifid phárolla: Déan taifid phárolla a phriontáil do na 

fostaithe faoi leith don tréimhse ón 1 Meán Fómhair 2021 go 

dtí an 31 Lúnasa 2022, déan cóip den achoimre párolla don 

bhliain 2021 a phriontáil agus bíodh cóip chúltaca den phárolla 

sábháilte agat ar mhéaróg chuimhne le haghaidh 2021 agus 

suas go dtí an 31 Lúnasa 2022. 

 

8. Ba cheart gurbh ionann an méid sa chuntas rialúcháin 

ÍMAT/ÁSPC/MSU/CMÁ (cód ainmniúil 2250) agus an méid 

ÍMAT/ÁSPC/MSU/CMÁ atá dlite do na Coimisinéirí Ioncaim 

amhail ar an 31 Lúnasa 2022. (Sa chás go mbaintear úsáid as 

irisí párolla). 

 

9. Ba chóir gurbh ionann an cuntas rialúcháin glanphá (cód 2200) 

agus náid, nó más ann d’iarmhéid, ba chóir é a mhíniú. 

 

10. Aon iarmhéideanna eile i gcuntais rialúcháin a bhaineann le pá 

(m.sh. táillí ceardchumainn, Scéim Pinsin Poiblí Aonair, 

Ranníocaíocht Aoisliúntais Bhreise), ba cheart gurbh ionann 

iad agus na méideanna dlite amhail ar an 31 Lúnasa 2022 (más 

rud é go bhfuil an párolla á thaifeadadh tríd an leabhar cúnta 

párolla). 

 

11. CBL: Caith súil siar ar ROS lena chinntiú go ndearnadh na 

tuairisceáin CBL go léir a chomhdú. Cuimhnigh nach mór duit 

tuairisceáin CBL a chomhdú fiú amháin más ionann do 

dhliteanas agus toradh nialasach. 

Ba cheart gurbh ionann an méid sa chuntas rialúcháin CBL (cód ainmniúil 

2260) agus an méid CBL atá dlite do na Coimisinéirí Ioncaim amhail ar 

an 31 Lúnasa 2022 (má táthar ag úsáid irisí CBL) 

 

12. RCT: Áirithigh go ndearnadh an hasbhaintí uile a baineadh ó 

Fhochonraitheoirí chun críocha RCT a thuairisciú chuig na 

Coimisinéirí Ioncaim.  

 

13. Cumann na dTuismitheoirí: Áirithigh go gcuirtear an 

doiciméadúchán airgeadais uile ar fáil do chuntasóir/iniúchóir 

seachtrach na scoile lena chuimsiú i gcuntais airgeadais 

bhliantúla na scoile.  

 

14. Déan liosta creidiúnaithe de láimh ar an 31 Lúnasa 2022 

(airgead atá dlite ag an scoil). Má úsáideann tú an mórleabhar 

ceannachán déan liosta a phriontáil de na creidiúnaithe gan íoc 

amhail ar an 31 Lúnasa 2022.  
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15. Scríobh amach liosta féichiúnaithe & réamhíocaíochtaí de 

láimh amhail ar an 31 Lúnasa 2022 (airgead atá dlite don 

scoil). Má úsáideann tú an mórleabhar díolachán déan liosta a 

phriontáil de na féichiúnaithe gan íoc amhail ar an 31 Lúnasa 

2022. 

 

16. Aon ioncam faighte sa bhliain reatha (2021/22), atá ceaptha 

don bhliain dar gcionn (2022/2023), ba chóir é a thaispeáint ar 

an gclár comhardaithe cód 2105 mar ioncam scoile faighte 

roimh ré. Bain úsáid as feidhm na roinne chun anailís a 

dhéanamh ar na cineálacha éagsúla laistigh den chuntas 

ainmniúil. Éascóidh sé seo tuarascáil ghníomhaíochtaí 

ainmniúla a reáchtáil de réir roinne do chód 2105 amhail ag an 

31.08.2022 chun críocha iniúchóireachta.  

 

17. Mar mhalairt ar sin, déan liosta de láimh d’ioncam/dheontais a 

fuair an scoil le linn a bliana 2021/22 a bhaineann le 

scoilbhliain 2022/2023 m.sh. deontas leabhar, táillí 

idirbhliana, táillí riaracháin na scoile, ranníocaíocht dheonach.  

 

18. Déan an t-ioncam don bhliain a athbhreithniú lena chinntiú gur 

cuimsíodh na deontais uile a fuarthas don chéad scoilbhliain 

eile sna cuntais mar ‘Dheontais Faighte Roimh Ré’ (cóid 

ainmniúla 2150-2152).  

 

19. Déan an t-ioncam agus caiteachas a athbhreithniú maidir le 

haon deontais/ioncam imfhálaithe agus tabhair ar aghaidh aon 

mhéideanna nach bhfuil caite mar dheontais/ioncam gan 

chaitheamh. Féach Aguisín 2 chun tuilleadh faisnéise a fháil. 

 

20. Cinntigh go bhfuil na hiarmhéideanna maidir le deontais 

COVID gan chaitheamh, cuimsithe mar is ceart sna cuntais. 

Féach Aguisín 1 chun tuilleadh faisnéise a fháil. 

 

21. Cruthaigh Tuarascáil ar Ghníomhaíochtaí Ainmniúla agus 

seiceáil ar breacadh síos na hidirbhearta go cruinn lena 

chinntiú gur tugadh cuntas ceart orthu. 

 

22. Ba cheart Coigeartuithe Deireadh Bliana maidir le 

creidiúnaithe, féichiúnaithe agus ioncam faighte roimhe ré a 

bhreacadh in SAGE 50 ar an 31.08.2022 más féidir sula ligtear 

dóibh leanúint ar aghaidh go deireadh na bliana. 
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E. Priontáil amach na Tuarascálacha Airgeadais atá molta le haghaidh 

dheireadh na bliana. 

Tuarascálacha Chun Tuarascálacha a Rith 

Comhardú Trialach Nominal codes > Trial Balance 

Nominal codes > Reports > Trial Balance 

Clár Comhardaithe Nominal codes > Reports > My nominal code reports >BOM 

Balance Sheet 
 

Brabús agus 

Caillteanas 

Nominal codes > Reports> My nominal code reports>BOM 

Income & Expenditure Account 
 

Gníomhaíocht 

Ainmniúil  

Nominal codes > Reports> Nominal Activity 
 

Íocaíochtaí / Fáltais 

Neamhréitithe 

Bank accounts > Reports > Unreconciled transactions 
 

Tuarascáil ar 

chreidiúnaithe 

aosaithe 

(le haghaidh 

scoileanna a 

úsáideann modúl an 

tSoláthraí amháin) 

Suppliers > Reports > Aged creditors > Aged creditors 

summary  

Suppliers > Reports > Aged creditors > Aged creditors detailed 

Suppliers > Reports > Activity > supplier activity detailed 

Tuarascáil ar 

fhéichiúnaithe 

aosaithe 

(le haghaidh 

scoileanna a 

úsáideann modúl an 

Chustaiméara 

amháin) 
 

Customers > Reports > Aged debtors > Aged debtors analysis 

summary  

Customers > Reports > Aged debtors > Aged debtors analysis 

detailed 

Customers > Reports > Activity>customer activity detailed 
 

Tuarascáil roinne  

do chód 2105 

Department > Reports > Nominal Analysis > Nominal 

Department analysis detailed > cód ainmniúil 2105 agus an 

réamhshocrú ar na huimhreacha roinne 
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Tuarascáil roinne  

Le haghaidh 

idirbhearta COVID 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Departments > Reports > Nominal Analysis > Nominal 

Department analysis detailed > baineann roinn 1 le COVID sa 

sampla seo. Lig mé don cód ainmniúil a bheith 

réamhshocraithe ionas go dtabharfaidh sé gach cód ina sanntar 

roinn 1. 

 
 
 

NB: Mura sannadh uimhir na rannóige ábhartha d’idirbhearta COVID ní 

bheidh siad le feiceáil sa tuarascáil seo.  

 

 

F. Cóip Chúltaca den Chóras 
 

Déan DHÁ Chóip chúltaca ar a laghad agus déan iad a shábháil in dhá shuíomh 

ar leithligh (Líonra/tiomántán crua seachtrach). Tabhair ‘Roimh Dheireadh na 

Bliana mar ainm air ’ - tá sé ríthábhachtach cóip chúltaca a dhéanamh de na sonraí 

sula ndéanfar deireadh na bliana a rith, toisc gurb é sin an t-aon bhealach chun 

dul ar ais go dtí staid réamhbhliana.  

Féach ar Chuid G maidir le deireadh do bhliana a rith i Sage 50. Is féidir tuilleadh 

eolais nó soiléiriú a fháil ar aon cheann de na saincheisteanna sa Treoirlíne seo 

trí theagmháil a dhéanamh leis an FSSU.  
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G. Deireadh Bliana a Phróiseáil in Sage 50 
 

Ba cheart do scoileanna idirchaidreamh a dhéanamh lena gcuntasóirí/lena n-

iniúchóirí seachtracha agus a iarraidh orthu a gcuid cuntas a athbhreithniú chomh 

luath agus is féidir agus Dréacht-chomhardú Trialach a chur isteach, ina n-áireofar 

athruithe ar na cuntais ioncaim agus caiteachais don bhliain. Féadfar na coigeartuithe 

iniúchta a bhfuil gá leo a chur isteach i Sage 50 sula ndéanfar deireadh na bliana a 

phróiseáil agus beidh na figiúir le haghaidh Ioncaim agus Caiteachais a bheidh le 

feiceáil sna cuntais arna gcur i gcartlann i gcomhréir, tríd is tríd, leis na Ráitis 

Airgeadais sínithe amhail ar an 31.8.2022. Má bhíonn tuilleadh athruithe i gceist tar 

éis próiseáil dheireadh na bliana, féadfar na coigeartuithe a dhéanamh ar chóid an 

Chláir Chomhordaithe dar dáta an 31.08.2022. 

Tá deireadh bliana bog ag Sage 50, rud a chiallaíonn gur féidir leat breacadh i do 

bhliain airgeadais nua sula ritheann tú an rogha Deireadh Bliana. Tá sé tábhachtach 

deimhin a dhéanamh go bhfuil dáta an idirbhirt i gceart. Beidh teachtaireacht le 

feiceáil ina gcuirfear in iúl go bhfuil an dáta lasmuigh den bhliain airgeadais reatha, 

cliceáil ar Ok nó Tá. Féadfar na tuarascálacha seo a leanas a rith i leith na bliana 

airgeadais nua go dtí go ritheann tú deireadh na bliana - Brabús agus Caillteanas ó 

Idirbhearta, Cláir chomhardaithe na nIdirbheart agus tuarascálacha ar Chomharduithe 

Trialacha na nIdirbheart. Tabhair faoi deara le do thoil go bhfuil na tuarascálacha sin 

beartaithe le haghaidh úsáid inmheánach/oifige agus nár cheart iad a úsáid le haghaidh 

cruinnithe an Bhoird Bhainistíochta.  

Chun tuarascálacha an Bhoird Bhainistíochta a rith i gcomhair na bliana nua, lena 

n-áirítear an buiséad le haghaidh 2022/2023 agus figiúir na bliana roimhe sin, ní 

mór Deireadh na Bliana Airgeadais a rith i Sage 50. Dá bhrí sin, ní féidir an próiseas 

deireadh bliana seo a chur siar rófhada sa Bhliain Airgeadais nua ar mhaithe le 

coigeartuithe iniúchta. Molaimid gurb é an dáta is déanaí chun Deireadh na Bliana a 

reáchtáil i Sage an chéad tseachtain i mí na Samhna 2022 chun a chinntiú go 

bhfaighidh an Bord Bainistíochta na tuairiscí cinntitheacha go léir don bhliain 

airgeadais nua. 

I gcás go bhfuil Sage suiteáilte ar líonra, ba chóir an gnáthamh deireadh bliana a rith 

ar an ríomhaire ar a bhfuil na sonraí. Má tá tacar mór sonraí agat, féadfaidh roinnt 

ama a bheith i gceist leis an bpróiseas a rith. Laghdófar an tréimhse ama sin má 

ritheann tú an gnáthamh ar an ríomhaire ar a gcoinnítear sonraí do chuntas. 
 

1. Deireadh na Bliana Airgeadais a Rith 

• Athraigh dáta an chláir-athraigh dáta an chláir go dtí lá deireanach na bliana 

airgeadais, m.sh. an 31 Lúnasa 2022. 

• Déan DHÁ chóip chúltaca agus cuir an lipéad ‘Before Year End’ orthu - tá 

sé ríthábhachtach cóip chúltaca a dhéanamh de na sonraí sula ndéanfar deireadh 
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na bliana a rith, toisc gurb é sin an t-aon slí chun dul ar ais go dtí staid 

réamhbhliana. Moltar dhá chóip chúltaca a dhéanamh mar réamhchúram ar eagla 

go ndéanfaí damáiste do na meáin chúltaca nó go gcaillfí ceann díobh. 

• Chun Deireadh Bliana a rith, roghnaigh Tools >Period End >Year End.  

• Ansin taispeánfar an fhuinneog deireadh bliana agus cuirfear na céimeanna go 

léir i gcrích. 

• Archive Data - roghnaigh an rogha seo chun sonraí a chur i gcartlann. Ar an 

mbealach sin beidh tú in ann féachaint ar sheansonraí gan seanchóipeanna cúltaca 

a thabhairt ar ais.  

• Seiceáil go bhfuil na sonraí a thaispeántar ag bun na fuinneoige Deireadh 

Bliana ceart sula roghnaíonn tú an rogha Rith Deireadh Bliana.  

• Roghnaigh YES má tá na dátaí Deireadh Bliana ceart.  

• Beidh scáileán dul chun cinn deireadh bliana le feiceáil ansin. Nuair a bheidh sé 

curtha i gcrích fiafrófar díot an mian leat iris Deireadh Bliana a phriontáil. 

Cliceáil ar ok. 

• Beidh teachtaireacht deiridh le feiceáil le deimhniú go bhfuil deireadh an bliana 

airgeadais curtha i gcrích, cliceáil ar OK. 
 

2. Déan na Sonraí a Sheiceáil Tar Éis Deireadh na Bliana a Rith  

Déan comhardú trialach Tugtha Ar Aghaidh a rith. Roghnaigh Modules >Nominal 

codes >Trial Balance i gcomhair na tréimhse roghnaigh Brought Forward 
 

• Deimhnigh nach bhfuil aon chóid ioncaim agus caiteachais ar an tuarascáil 

sin 

• Ansin, déan do shonraí a sheiceáil arís. File>Maintenance > check Data 

• Ar deireadh, déan cóip chúltaca eile de na sonraí agus cuir ‘After Year End’ 

mar lipéad uirthi. 

• NÁ déan an rian iniúchta a ghlanadh. Má tá sonraí cuntasaíochta le 

haghaidh níos mó ná dhá bhliain ar Sage 50 áfach, agus gur cosúil go bhfuil 

próiseáil Sage moill mar thoradh ansin ba cheart smaoineamh ar an rian 

iniúchta a ghlanadh. Féach an rannán Sage 50 den láithreán gréasáin le 

haghaidh sonraí maidir leis an bpróiseas sin. 
 

Tá sonraí iomlána maidir le deireadh bliana a rith le fáil sa ‘Lámhleabhar FSSU 

ar Chuntais SAGE - Cuid 8’  

3. Ba cheart Buiséad na Scoile le haghaidh 2022/2023 a iompórtáil anois 

chuig Sage 50.   

Tá bileog excel nua san áireamh sa Teimpléad Buiséid 2022/2023 ar a dtugtar "Sage 50 

Import" ina dtugtar achoimre ar na cóid ainmniúla agus na figiúirí buiséid iomlána don 

https://www.fssu.ie/post-primary/topics/sage-50-accounts/manual-guides/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/manual-guides/
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bhliain. Is féidir na sonraí i gColún A, B & D den bhileog seo a chóipeáil isteach i dteimpléad 

atá ar fáil i Sage 50, agus cuirfidh sé seo ar chumas na sonraí buiséid a iompórtáil isteach i 

Sage 50. Roimhe seo bheadh na figiúirí seo le líonadh isteach de láimh i dTeimpléad 

Iompórtála Buiséid Sage. 

Féach ar ár suíomh gréasáin anseo chun treoir a fháil mar aon le físeán 

taispeána ar an bpróiseas. 

Déan deimhin de go bhfuil na cóid ainmniúla céanna ag do theimpléad 

iompórtála buiséid agus atá i do chuntais Sage 50 agus go ndéanfar cóip chúltaca 

sula ndéantar an fhaisnéis a iompórtáil.  

4. Coigeartuithe iniúchta 

Nuair atá deireadh na bliana rite, ba cheart an dáta 31.08.2022 a chur le haon 

choigeartuithe iniúchta ar Chuntais 2021/22 agus ní ceart iad a dhéanamh ach i leith 

cóid an Chláir Chomhardaithe agus ba cheart coigeartuithe Ioncaim agus Caiteachais 

a bhreacadh i gcód Cúlchistí Ioncaim 2710. 

5. Comparáidí na bliana roimhe sin 

Do na scoileanna sin ar mian leo go mbeadh comparáidí idir an bhliain roimhe agus 

an bhliain reatha go dtí seo le feiceáil ina gCuntas Ioncaim agus Caiteachais in ionad 

na bliana roimhe ina hiomláine, tá an tuarascáil roghnach sin mar aon le treoracha 

maidir le cóipeáil isteach in Sage 50 le fáil sa rannán Ag tosú le Sage 50 dár láithreán 

gréasáin. 

H. Oiliúint maidir le Sage 50 

I mbliana tá FSSU ag cruthú sraith d’fhíseáin Sage 50 ar éileamh a bheidh ar fáil ar 

ár suíomh gréasáin. Beidh na físeáin ar éileamh gearr agus tabharfar treoir iontu 

maidir le topaicí ar leith amhail Cairt na gcuntas a leasú, an buiséad a iompórtáil agus 

breisithe sócmhainní seasta a thaifeadadh i Sage 50 ag baint úsáide as na cóid 

ainmniúla is déanaí. Reáchtálfaimid roinnt seisiún oiliúna seimineár gréasáin beo 

d'úsáideoirí nua freisin agus chun ullmhú do dheireadh na bliana agus chun críoch a 

chur leo.  

Leanfaidh FSSU ag cur tacaíocht agus oiliúint leanúnach ar fáil chun éascú a 

dhéanamh agus cabhrú le scoileanna na gnéithe nua atá ar fáil in Sage 50cloud 

Accounts go háirithe le húsáid fothaí bainc mar go bhféadfaidh sé seo cur le 

héifeachtúlacht agus tráthúlacht fheidhm na gcuntas. 

Guthán: 01-269 0677  

info@fssu.ie  

 

An 7 Meán Fómhair 2022 

https://www.fssu.ie/post-primary/topics/sage-50-accounts/training/training-videos/importing-the-budget/
mailto:info@fssu.ie
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Aguisín 1  
 

Cur Chuige Cuntasaíochta maidir le Deontais COVID gan Chaitheamh  

 
Ní mór cuntas a thabhairt ar an gcuid sin d’iarmhéideanna deontas imfhálaithe nár 

caitheadh ag deireadh na bliana faoin gcód ábhartha (faoi na cóid ábhartha) (2181-

2185) i gcairt na gcuntas.  

 

Lean na céimeanna thíos chun cuntas a thabhairt ar na deontais nár caitheadh: 

 

▪ Céim 1: Ríomh méid an deontais nár caitheadh amhail ar an 31.08.2021 

(Ioncam Lúide Caiteachas) 

 

▪ Céim 2: Déan iontráil dar dáta 31.08.2022 chun an t-airgead nár caitheadh a 

aistriú chuig an gclár comhardaithe.  

 

▪ Tabhair do d'aire: Ós rud é go bhfuil an chuid neamhchaite de dheontais 

COVID ag an 31.08.2022 le cur ar ais chuig an Roinn faoin 30.09.2022, ní gá 

na deontais a chur ar ais sa chód Ioncaim agus Caiteachais ar an 01.09.2022 

 

Cliceáil anseo le haghaidh bileog oibre chun cabhrú le cuntas a thabhairt ar dheontais 

COVID neamhchaite. 

 
 
 

 

 

 

 

 
 
 
 
 

Deontas 

Céim 1 Céim 1 Céim 1 Céim 2 

Ioncam 
 

Caiteachas 
 

Iarmhéid 
an 

Deontais 
amhail ar 

an 
31.08.2022 

 

Déan iontráil maidir leis an méid 
gan chaitheamh ar an 31.08.2022 

Cód 
Ainmniúil 

Suim Cód 
Ainmniúil 

Suim Suim Cód 
Dochair 

 

Cód 
Creidmheasa  

Rannóg 

Deontas 
Caipitíochta 
COVID le 
haghaidh 
PPE 

3281 €19,000 5802 €18,600 €400 3281 2182 COVID 

https://www.fssu.ie/post-primary/topics/return-of-unspent-covid-capitation-funding-supports/
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Aguisín 2  
 

Cur Chuige Cuntasaíochta maidir le Deontais/Ioncam gan Chaitheamh 

 
Faightear roinnt deontas/ioncam chun críche ar leith, mar shampla an deontas TFC agus 

an deontas maoirseachta agus ionadaíochta. Tugtar deontais imfhálaithe orthu sin. Ba 

cheart an sciar de na deontais sin nach bhfuil caite a chur siar go dtí go gcaithfear é sa 

scoil. 

 

Ní mór cuntas a thabhairt ar an gcuid sin d’iarmhéideanna deontas imfhálaithe nár 

caitheadh ag deireadh na bliana faoin gcód/faoi na cóid ábhartha (2160-2180) ar an 

gclár comhardaithe sa chairt chuntas.  

 

Is samplaí de dheontais imfhálaithe iad na deontais seo a leanas. 

 

➢ Deontas Leabhar, Deontas um Mhaoirseacht agus Ionadaíocht, Deontas TFC, 

Deontas Tionlacaí Bus, Deontas Béile Scoileanna, Gach Deontas Caipitil srl. 

 

Lean na céimeanna thíos chun cuntas a thabhairt ar na deontais nár caitheadh: 

 

▪ Céim 1: Ríomh méid an deontais nár caitheadh amhail ar an 31.08.2022 

(Ioncam Lúide Caiteachas) 

 

▪ Céim 2: Déan iontráil dar dáta 31.08.2022 chun an t-airgead nár caitheadh a 

aistriú chuig an gclár comhardaithe.  

 

▪ Céim 3: Déan iontráil dar dáta an 01.09.2022 chun an ghné neamhchaite a 

aistriú ar ais chuig an tuarascáil Ioncaim agus Caiteachais le húsáid sa 

bhliain dar thús an 31.08.2022. 
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Tábla2: Sampla de Chuntas a Thabhairt ar dheontas nár caitheadh 

 
 
 
 
 

Deontas 

Céim 1 Céim 1 Céim 1 Céim 2 Céim 3 

Ioncam 
 

Caiteachas 
 

Iarmhéid 
an 

Deontais 
amhail ar 

an 
31.08.2022 

 

Déan iontráil 
maidir leis an 

méid gan 
chaitheamh ar 
an 31.08.2022 

 

Déan iontráil 
maidir leis an 

méid gan 
chaitheamh 

ar an 01.09.2022 
 

Cód 
Ainmniúil 

Suim Cód 
Ainmniúil 

Suim Suim Cód 
Dochair 
 

Cód 
Creidmh
easa  

Cód 
Dochair 

Cód 
Creidmhe
asa  

Deontas 
Leabhar 

3150 €9,600 4730 €8,900 €700 3150 2160 2160 3150 

Deontas le 
haghaidh 
Maoirseacht 
agus 
Ionadaíocht 

3240 €5,130 4150 €4,200 €930 3240 2170 2170 3240 

Deontas 
Caipitil faoi 
chomhair 
Leabhair 
don 
Leabharlan
n Scoile 

3155 €15,000 4641 €1,000 €14,000 3155 2161 2161 3155 

Deontas le 
haghaidh 
Tionlacaith
e Bus 

3294 €4,000 4196 €3,500 €500 3294 2171 2171 3294 

DSP Béilí 
Scoile 

3296 €30,000 4912 €26,000 €4,000 3296 2171 2171 3296 

Straitéis 
Dhigiteach/
Deontas 
TFC 
(Neamhchai
piteal) 

3230  €27,500 4410  €17,500 €10,000 3230  2165 2165 3230 
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Straitéis 
Dhigiteach/
Deontas 
TFC 
(Neamhchai
piteal) 

3921 €27,500 1461 
(1460) 

€17,500 €10,000 3921 2165 2165 3921 

Deontas 
Roinnte 
Digiteach 
(Neamhchai
piteal) 

3230  €20,000 4410  €17,500 €2,500 3230  2179 2179 3230 

Deontas 
Roinnte 
Digiteach 
(Caipiteal) 

3921 €20,000 1461 
(1460) 

€17,500 €2,500 3921 2179 2179 3921 

Deontas 
Caipitil: 
Foirgneamh 

3900 €90,000 3940 €80,000 €10,000 3900 2171 2171 3900 

Deontas 
Caipitil: 
Trealamh 

3920 €25,000 1421 €20,000 €5,000 3920 2171 2171 3920 


